
SynthFont MidiExpander 

Documento gentilmente tradotto in italiano da Alberto Galluzzo (http://www.goldmidisf2.com) 

Descrizione 

SynthFont è un sintetizzatore software ("MIDI to WAV/MP3", "Midi Expander") utile per la riproduzione di file midi 
formato standard, utilizzando come fonte sonora i famosissimi SoundFonts (files "SF2") o altri file audio in formato 
DLS, GIGA, 404, GUS, SFZ. Inoltre SynthFont, sostituisce alla grande tutte le funzioni in modo virtuale, delle tante 
schede audio di tipo hardware come, SoundBlaster Live!, Audigy o tanti moduli esterni dal costo elevatissimo, 
fornendo all’utente un'interfaccia con tutte le funzioni per la gestione ed editing dei SoundFonts e MIDI files. 
 
Una delle caratteristiche principali di SynthFont, è la possibilità di scegliere e assegnare i nostri soundfonts ad ogni 
canale MIDI, questo permetterà di generare in uscita, una riproduzione formato audio come WAV o MP3 di alta 
qualità. SynthFont genera un file chiamato “Arrangement” dove conserverà tutte le personalizzazioni di editing 
effettuate dall’utente, permettendo così di salvare un nuovo file MIDI personalizzato.  
 
Per i musicisti più esigenti, che vogliono esprimere la loro musica raggiuggendo la massima qualità con il minimo 
investimento, ma soprattutto utilizzando il MIDI file come base per la loro musica, SynthFont da la possibilità di 
utilizzare strumenti musicali in formato VST come fonte esterna, al fine di aumentare la qualità audio e renderla 
ancora più professionale. 
 
La prima cosa da fare prima di caricare un file midi, è selezionare il SoundFont predefinito che sarà  richiesto alla 
prima escuzione del programma SynthFont. 
In un secondo momento è sempre possibile sostituire dal menù principale opzione "File", il soundfont con un altro 
che rispetti obbligatoriamente lo standard GM(General Midi con 128 presets) o GS (General Standard oltre i 128 
presets).  
Il pacchetto di installazione di SynthFont include un GM SoundFont basico di piccole dimensioni "SYNTHGMS.sf2". 
Se desideri un'alternativa migliore, scarica un file dalla pagina web di SynthFont. (I file sono in un formato compresso 
(sfArk) che SynthFont può decomprimere.) 

 
Ci sono tre livelli utente: "Just Playing", "Midi Guru" e "Expert Wizard (Procedura avanzata)". È possibile modificare 

la modalità nel menu principale con la scelta “View”.:  
 

 
  



La differenza tra queste tre modalità sta nel numero di pagine visualizzabili e il loro Controllo:  

 
Nella modalità " Expert Wizard (Procedura avanzata)" hai accesso a otto opzioni: 
 
1 Files & Folders - per utilizzare la playlist dei files o l'Explorer integrato 
2 Pianoroll - per aprire ed editare il file midi  
3 Midi events - per aprire ed editare in modo più approfondito il midi file (solo per esperti irriducibili!). 
4 Plug & Play - Selezionado dal menù principale questa opzione, si accede al rack del sintetizzatore, con la 
possibilità di editare alcune cose. Inoltre, verrà visualizzato l'elenco delle tracce, che ti dà la possibilità di accesso a 
tutta una serie di parametri editabili. 
5 Preset layers – possibilità di vedere il contenuto di un SoundFont 
6 Splits in layer - possibilità di vedere il contenuto di un SoundFont  
7 Sample data - - possibilità di vedere il contenuto di un SoundFont  
 
Le opzioni in corsivo non sono visibili in modalità “Just Playing”, mentre le pagine 5,6 e 7 non sono visibili in modalità 
“Midi Guru”. Si noti, tuttavia, che le pagine 5, 6 e 7 possono talvolta essere nascoste anche in modalità "Modalità 
avanzata" (ad esempio, quando alla traccia selezionata è assegnato uno strumento VST). 

Barra principale degli strumenti: 

 

 
I pulsanti nella barra degli strumenti principale sono:  
"Exit", per uscire dal programma;  
"Setup and Options", per modificare una serie di impostazioni e installare effetti e strumenti VST;  
"Save Arrangement", per salvare la selezione di SoundFont, effetti e strumenti VST e altre impostazioni simili in un 
file (NOTA: premere il pulsante DESTRO del mouse per visualizzare l'alternativa Salva con nome ...);  
"Open Midi or Arrangement", per aprire un file midi o il suo arrangiamento (premi il tasto destro del mouse per un 
elenco dei tuoi Arrangiamenti);  
"SoundFont File ...", per aprire un SoundFont e assegnarlo a un canale midi (premere il tasto destro del mouse per 
un elenco della cronologia);  
"Play to Speakers", per riprodurre il file midi sull'uscita audio standard (altoparlanti o cuffie);  
"Play to File", per creare un file audio adatto alla scrittura di un CD,  
"Play to Both", per inviare l'audio sia all'uscita standard che a un file (più lento rispetto al semplice utilizzo di "Play 
to File");  
"TurnMidi imput ON ”, per riprodurre non da un file midi ma in tempo reale da una sorgente di ingresso midi a cui 
potrebbe essere collegata ad esempio una tastiera;  
"Save Midi", per salvare un file midi che tutte con le modifiche effettuate. 

 



Schermata principale: 

 
 
L'immagine sopra mostra la pagina "4 Plug & Play", una delle 8 pagine accessibili dalla finestra principale. Le pagine 
sono: "1 Files & Folders", "2 Pianoroll", "3 Midi events", "4 Plug & Play", "5 Preset layers", "6 Splits in layer", "7 
Sample data".  
 
Di queste pagine, le opzioni 2, 3 e 4 gestiscono i dati dei file midi, mentre 5, 6 e 7 riguardano i dati del SoundFont 
precedentemente selezionato. La tabella nella parte metà inferiore elenca le tracce del file midi con a destra un mixer 
molto semplice. Normalmente ogni traccia fa riferimento a un solo un canale midi, anche se  spesso lo stesso canale 
midi viene utilizzato da molte tracce.  
 
Con la selezione dell'opzione "4 Plug & Play", e  quando è caricato un file midi, SynthFont visualizza la pagina come 
in figura. 
 
La pagina Plug & Play è divisa in tre parti. La parte superiore contiene alcune funzioni relative al modo in cui il 
motore di sintesi elabora i dati midi. La parte centrale contiene una serie di pulsanti importanti. La parte inferiore 
mostra semplicemente un elenco di tracce e canali midi nel file midi. Un file midi può contenere un numero qualsiasi 
di tracce, ma solo 16 canali midi. I dati per una particolare sequenza midi possono essere suddivisi in più tracce 
durante la riproduzione attraverso un singolo canale midi. La maggior parte delle impostazioni di arrangiamento in 
SynthFont sono relative al canale midi e non alla traccia. Ad esempio, è possibile assegnare diversi SoundFont (o 
strumenti VST) a ciascuno dei 16 canali, ma non a ciascuna delle N tracce. Pertanto, se due tracce vengono 
riprodotte attraverso lo stesso canale, condivideranno anche lo stesso SoundFont.  
 



Opzione Plug & Play parte superiore: 

 
Beats Per Minute: Il file midi contiene i dati che definiscono il BPM (Battute per minuto) per la canzone. Questi dati 
possono cambiare o rimanere gli stessi. È possibile modificare la velocità di riproduzione complessiva modificando 
il fattore di velocità. Utilizzare i quattro pulsanti su / giù per modificare il fattore in unità di decimi (".1") o centinaia 
(".01"). È possibile creare un'automazione che può essere memorizzata nel file di arrangiamento, anche se 
probabilmente è meglio modificare direttamente i dati BPM nel file midi. È possibile attivare un metronomo che farà 
clic alla velocità BPM corrente. 
 
Playback volume: Ci sono due cursori che puoi muovere, sinistro e destro. Normalmente questi sono sincronizzati 
tra loro e cambiano allo stesso tempo. Per modificarli separatamente è necessario disattivare il pulsante di 
sincronizzazione. Sopra il pulsante Sync c'è un pulsante Soft. Commutalo per attivare un limitatore morbido per 
ridurre la distorsione quando il segnale diventa troppo alto. In alto c'è il pulsante Auto per la manipolazione delle 
automazioni per il volume (di nuovo è probabilmente più saggio modificare direttamente i dati del volume nel file 
midi). 
 
Output VST Effects (”Fx”): È possibile assegnare effetti VST di terze parti a 17 linee separate o "bus". Il primo bus 
è il bus principale, che è sempre utilizzato da tutti i canali midi. Gli altri 16 bus possono essere assegnati a ciascun 
canale midi separatamente. Sotto l'elenco a discesa "Catena di bus" ci sono sei pulsanti per la manipolazione degli 
effetti VST. È necessario installare o registrare gli effetti VST in "Configurazione e opzioni" prima di poterli utilizzare. 
 
Playback progress: I due piccoli triangoli sotto la barra di avanzamento possono essere trascinati per definire 
l'intervallo di riproduzione di Bar/Beat. Ci sono sette piccoli pulsanti: riproduci / interrompi, avanti di una o dieci 
misure, pausa, avanti al marker successivo, indietro o dieci misure, torna al marker precedente e crea un marker 
mew. (I marker possono essere visualizzati e manipolati nel riquadro Pianoroll). 
 
Synth Options button: Questo pulsante apre la finestra di dialogo “Impostazioni e Opzioni” e va direttamente alle 
opzioni Synth nella finestra di dialogo. 
 
Leardini System: Il Sistema Leardini è un sistema ideato da un italiano non vedente di nome Eliseo Leardini. Il 
sistema di "Audiolettura" prende il nome dal suo ideatore. In breve, il sistema consente di cantare e parlare di musica. 
È quindi adatto a persone non vedenti che non hanno la capacità di leggere uno spartito musicale. 
 
Playback Range: Qui è possibile definire quale parte del brano si desidera suonare. È possibile scegliere di utilizzare 
i marker, che sono definiti nel file midi o successivamente dall'utente (e memorizzati nel file di arrangiamento). Inoltre 
è possibile selezionare per riprodurre un'area definita da una serie di numeri di Bar e Beat. L'intervallo di riproduzione 
è visibile anche nella casella della percentuale di riproduzione a sinistra, dove i marcatori vengono visualizzati come 
due linee verticali nella barra di avanzamento e i valori di inizio e fine Bar/Beat vengono visualizzati come due piccoli 
triangoli sotto la barra di avanzamento. Se si seleziona un intervallo di riproduzione, si può scegliere di riprodurlo in 
loop un numero di volte o indefinitamente. 
 
Voices: anche questo è solo a scopo informativo, mostra il numero di voci simultanee, o campioni d'onda, che 
suonano contemporaneamente (spesso indicato come "polifonia"). SynthFont può gestire al massimo fino a 512 voci, 
ma la CPU potrebbe porre limitazioni al numero che si possono raggiungere senza causare interruzioni nell'uscita 
audio. NOTA: che quando si riproduce un file, non ci sono limiti di CPU. 
 
CPU: questo è solo per informazione, mostra il carico della CPU durante la riproduzione. 
 
 



Opzione Plug & Play parte centrale: 

 
  
Nella parte centrale ci sono due frighe di pulsanti. Nella riga in alto, da sinistra a destra: 

1. Adattare il contenuto dell'elenco delle tracce allo spazio disponibile. Normalmente questo viene fatto 
automaticamente. 

2. Suona solo la traccia selezionata (in automatico tutte le altre tracce saranno silenziate). Questa selezione 
può essere memorizzata nel file di arrangiamento. NOTA: nelle altre tracce vengono silenziate solo le note, 
mentre tutti i controller midi restano attivi e possono causare effetti inaspettati, come il pitch bend o un 
cambio di programma midi.  

3. Mute traccia selezionata. Nel selezionare la traccia e metterla in “Mute”, verranno silenziati solo i dati delle 
note, altri eventi midi come i cambi di programma e controller restano attivi. Questa selezione può essere 
memorizzata nel file Arrangement.  

4. Suonare le note nelle tracce selezionate. Questo è l'opposto di “Mute”. 

5. Disattiva TUTTI gli eventi nelle tracce selezionate. Ora, non solo le note, ma anche tutti gli altri eventi 
saranno "silenziiati". Questa selezione può essere memorizzata nel file Arrangement.  

6. Attiva TUTTI gli eventi nelle tracce selezionate.  

7. Pulsante "home" ripristina tutte le attivazioni a livello iniziale predefinito.  

8. Crea una nuova traccia midi. Questo dovrà essere salvato nel file midi come una nuova traccia.  

9. Crea una nuova traccia audio. Puoi riprodurre un file audio insieme ai dati midi. Utilizzare questo pulsante 
per creare una traccia e assegnarvi il file audio. Questi dati non vengono memorizzati nel file midi ma nel 
file Arrangement. 

10. Modificare i dati della traccia audio.  

11. Armare una traccia audio per registrare dati audio da una sorgente di ingresso standard (definita in 
Configurazione e Opzioni)  

12. Elimina la traccia selezionata  

13. Apri il SoundFont della traccia selezionata nell'editor Viena SoundFont (se installato)  

14. Cambia lo slot del canale midi. Internamente SynthFont può utilizzare fino a 32 canali midi, mentre il MIDI 
stesso solo 16. È possibile modificare facilmente il numero del canale interno con questo pulsante. Il canale 
3 diventerà il canale 19 (3 + 16) e così via. Notare che internamente (e per specifica) i canali sono numerati 
da 0 a 15, ma se si preferisce utilizzare l'intervallo da 1 a 16 è possibile modificarlo in “Setup e Opzioni”.  

15. Aggiungere una sottotraccia traccia alla traccia selezionata. Questo livello può avere altri SoundFont e 
strumenti definiti rispetto alla traccia genitore. Tuttavia, utilizzerà gli stessi dati midi, quindi i dati non vengono 
duplicati.  

16. Modifica/crea gruppo di file. Un gruppo di file, è una raccolta di SoundFont che si possono utilizzare per 
sostituire di qualsiasi singolo SoundFont. Pertanto, se sei soddisfatto della maggior parte degli strumenti nel 
tuo SoundFont predefinito, ma non con il violoncello, puoi scegliere un altro SoundFont per sovrascrivere il 
violoncello originale. Questo SoundFont prioritario può essere un altro GM SoundFont o semplicemente un 
singolo strumento per esempio un Cello SoundFont.  

17. Impostare i parametri PAN di diffusione. Questa è una funzione molto speciale per la riproduzione di brani 
di pianoforte se si vuole creare una diffusione spaziale più realistica delle note.  

18. Mostra/nascondi pianoforte virtuale. Usa la tastiera virtuale per ascoltare gli strumenti nel SoundFont.  

19. Mostra il gestore di file audio. Questo è uno strumento che puoi utilizzare per ascoltare i preset nella tua 
raccolta di file audio al fine di scegliere il preset più adatto per la melodia. 

20. Mixer: "Q Standard" / "R Extended". Vedere la sezione seguente sull'uso del mixer. 
 
La seconda riga di pulsanti è dedicata esclusivamente per intervenire sulla lista delle tracce, come di seguito è 
descritto. 

 



Elenco Tracce Plug & Play: 

L'elenco delle tracce contiene anche una serie di pulsanti importanti per l’utilizzo di SynthFont: 

1. Track - premere questo pulsante per aprire uno strumento e per riorganizzare le tracce. La modifica può 
essere salvata nel file midi o nel file Arrangement. 

2. Colr - il colore usato per le note nel Pianoroll 

3. Name – premere per modificare il nome della traccia. 

4. Size – il numero di note in una traccia o, durante la riproduzione, il numero di note in riproduzione. 

5. CHN – utilizzare questo pulsante per sovrascrivere il valore del canale. È possibile utilizzare questo pulsante 
per passare da uno slot di canale all'altro.  

6. BANK – utilizzare questo pulsante per visualizzare la configurazione del banco. I banchi sono spiegati in 
dettaglio in una sezione successiva. 

7. MIDI Program – questo pulsante fa apparire un menu di programmi General Midi (tutti i 128). Puoi usarlo per 
cambiare il program change presente nel file midi. NOTA devi salvare il file midi affinché questa modifica 
diventi permanente nel file MIDI Arrangement. Importante sapere che una traccia MIDI può contenere più 
program change. Nell'esempio sopra, quattro tracce mostrano il program change in grassetto, il che significa 
che ci sono più cambi di programma. Quando si seleziona una di queste tracce, verrà visualizzato un nuovo 
pulsante accanto al nome del programma: "Seleziona". Premere questo pulsante per visualizzare un menu 
di modifiche al programma. 

8. Vol – il livello di volume MIDI predefinito 

9. PAN – c'è uno strumento speciale per sovrascrivere questo valore - Pan Spread. 

10. SF File... – premere per cercare e selezionare un SoundFont adatto (o un altro file audio). È inoltre possibile 
selezionare un file dall'elenco a discesa della cronologia  

11. VSTi – utilizzare questo pulsante per selezionare uno strumento VST da utilizzare al posto di un SoundFont. 
Di nuovo puoi sceglierne uno direttamente dall'elenco a discesa 

12. Out (Midi Out) – premere per selezionare una porta Midi Out a cui inviare i dati midi.  

13. SF2 Preset – utilizzare questo pulsante per selezionare lo strumento da utilizzare se si desidera 
sovrascrivere la scelta del programma midi predefinito. (Internamente gli strumenti SoundFont sono chiamati 
"preset" perché un "preset" è costituito da uno o più strumenti. (Vedere la sezione sulla struttura di 
SoundFont).  

14. FxBus – selezionare un bus di effetti VST dal menu. 

15. PSM – (Pitch Shifting Method). Pitch Shifting viene utilizzato per creare audio per le note che non sono 
direttamente memorizzate in SoundFont. Più i dati audio originali devono essere spostati dalla loro nota 
fondamentale, maggiore è il rischio di rumore secondario artificiale o effetti di aliasing. Il miglior metodo PSM 
chiamato Perfect Pitch offre risultati migliori in casi come questi, ma è molto più lento e consuma la CPU 
rispetto al metodo standard. Usa con attenzione!  

16. MIXER – premere questo pulsante per selezionare la funzione mixer. I dati editati nel mixer vengono 
memorizzati nel file Arrangement. 

 
Inoltre esiste menu che può essere visualizzato per le tracce premendo il pulsante destro del mouse. 
 

Tracce e Canali MIDI 

SynthFont è utilizzabile alla gestione del canale midi, come qualsiasi sintetizzatore hardware. I file midi sono spesso 
organizzati in tracce. SynthFont gestisce le tracce, ma è molto consapevole del canale, il che significa che molte 
cose che fai nel file Arrangement hanno effetto su tutte le tracce che fanno riferimento a un certo canale midi. Ad 
esempio, quando si assegna un SoundFont a una traccia, lo si assegna effettivamente al canale Midi, il che significa 
che SoundFont cambierà per tutte le altre tracce utilizzando lo stesso canale MIDI. Ogni traccia può fare riferimento 
a un numero qualsiasi di canali e due o più tracce possono condividere gli stessi canali. Ci sono 16 canali 
nell'implementazione midi standard. Questa è una limitazione non necessaria per un sintetizzatore software e 
SynthFont internamente può utilizzare un numero qualsiasi di canali. Attualmente sono disponibili 32 canali. (I canali 
Midi sono solitamente numerati 0-15 (e 16-31) o 1-16 (e 17-32) (puoi scegliere lo schema di numerazione). Il canale 



delle percussioni è di default il canale 9 (o 10), sebbene in SynthFont puoi assegnare liberamente un banco di 
percussioni a qualsiasi canale 
 

Il Mixer 

Sono disponibili due mixer alternativi: lo “Standard” e il “Extended”. Il mixer Standard è disponibile anche per gli 
utenti senza licenza di registrazione, mentre il mixer Extended è aperto solo agli utenti registrati. Il mixer standard 
permette di modificare un solo parametro alla volta. È possibile scegliere il parametro dall'elenco a discesa sul 
pulsante in alto (leggendo "Volume" nell'immagine sopra). I parametri sono: 
 
Volume: Cambia il volume generale della TRACCIA (non per il canale MIDI). Notare che l'intervallo è molto più ampio 
del normale intervallo di volume del canale MIDI. 
 
Pan position:). Cambia la posizione pan generale della TRACCIA (non per il canale MIDI 
 
Vel Dynamics: Ogni nota ha il proprio valore di velocity. Il Vel Dynamics cambia la gamma di questi valori di velocità. 
Notare che il limite inferiore è sempre 0,0 (N / A = non applicato) ma il limite superiore è molto più alto del limite 
superiore MIDI. 
 
Transpose: Cambia i valori delle note su/giù in incrementi di semitoni 
 
Transpose all: Cambia la tonalità del brano su/giù in incrementi di semitoni. 
 
LP Filter type: Tutte e tre le alternative di filtro sono filtri passa-bas Low Pass dello stesso tipo di base ma con diversi 
gradi di pendenza. 
 
LP Filter amount: La quantità di segnale inviato a Low Pass filter. 0% = none, 100% = all. 
  
Puoi modificare i valori direttamente nelle celle o utilizzare la barra di scorrimento. È inoltre possibile utilizzare un 
menu aggiunivo (pulsante destro del mouse) per impostare alcuni valori predefiniti: 
 
Questo menu mostra anche alcune scorciatoie utilizzando la tastiera disponibili. 
 
Il mixer esteso consente di modificare quattro valori contemporaneamente. Ora non c'è la trackbar, ma puoi usare 
invece up/down spinwheel: 

  



Tasti Rapidi 

ctrl+A = save midi file 

shift+ctrl+A = save midi file AS 

ctrl+B = bank manager 

ctrl+C = decrease mixer value, fine 

ctrl+D = Define Default SoundFont Overrides 

ctrl+E = add VST effect to bus 

shift+ctrl+E = remove VST effect 

ctrl+F = increase mixer value, fine 

ctrl+G = edit group file 

ctrl+H = Define default SoundFont 

ctrl+I = activate/inactivate track 

ctrl+J = shift BPM factor down 0.01 step (fine) 

ctrl+K = show/hide Virtual Keyboard 

ctrl+L = add track layer 

ctrl+M = mute/unmute notes 

ctrl+N = new midi 

ctrl+O = reopen midi file 

ctrl+P = play track solo 

ctrl+Q = stop playing 

ctrl+R = arm for recording audio 

ctrl+S = save arrangement 

shift+ctrl+S = save arrangement as 

ctrl+T = Show/hide Karaoke Lyrics 

ctrl+U = shift BPM factor up 0.01 step (fine) 

ctrl+V = playback volume up 

shift+ctrl+V = playback volume down 

ctrl+W = show Sound File Manager 

ctrl+X = (unused) 

ctrl+Y = (unused) 

ctrl+Z = (unused) 

 

Alt+A = show Piano Player window 

Alt+B = play to both (speakers and file) 

Alt+C = set loop count 

Alt+D = open Edit menu 

Alt+E = open Setup dialog 

Alt+F = open File menu 

Alt+G = play next song (playlist) 

Alt+H = open Help menu 

Alt+I = (unused) 

Alt+J = (unused) 

Alt+K = (unused) 

Alt+L = toggle loop 

Alt+M = toggle metronome (fixed) 

Alt+N = (new midi track, F9) 

Alt+O = open an arrangement or midi file 

Alt+P = open Play menu 

Alt+Q = show mixer standard view 

Alt+R = show mixer combo view 

Alt+S = play to speakers 

Alt+T = open SF2-tools menu 

Alt+U = assign SoundFont file (F3) 

Alt+V = open View menu 

Alt+W = write to file 

Alt+X = exit 

Alt+Y = synth options 

Alt+Z = Freeze BPM factor 

Alt+"-" = show VST-Fx (VST-Effects) menu 

 

Alt+1..+8 + change pane 

 



F2 = rename track 

F3 = assign SoundFont to program change in track 

F4 = assign SoundFont preset to program change in track 

F5 = Setup and Options 

F6 = go to Tracks list 

Alt+BkSp = restore mute and activation to default 

 

A = show mixer transpose all 

B = (unused) 

C = decrease mixer value, course 

D = show mixer velocity dynamics 

E = Setup/Options 

F = increase mixer value, course 

G = play next song (playlist) 

H = (unused) 

I = (unused) 

J = shift BPM factor down 0.1 step (course) 

K = (unused) 

L = show mixer low pass filter type 

M = show mixer low pass filter amount 

N = (unused) 

O = (unused) 

P = show mixer pan 

Q = show mixer standard view 

R = show mixer combo view 

S = set mixer value to default 

T = show mixer transpose 

U = shift BPM factor up 0.1 step (course) 

V = show mixer volume 

W = pause playback (also Pause/Break key works) 

X = set mixer value to maximum 

Y = (unused) 

Z = set mixer value to minimum 

 

HOME = avvia / arresta la riproduzione sugli altoparlanti (invece di BARRA SPAZIATRICE, vedere Configurazione 
per modificare) 
 

  



Breve descrizione della struttura di un SoundFont 

 
 
La struttura generale di un SoundFont è descritta sopra. Il Preset (spesso indicato anche come "strumento", un 
"program change", o una "patch") è la caratteristica che è visibile all'esterno. I preset vengono uniti in banchi. Ciascun 
banco può contenere 128 Preset e questi sono numerati da 0 a 127 o da 1 a 128 (in SynthFont 0-127). Possono 
esserci 128 banchi (numerati 1-128 o 0-127). Quindi il numero totale di Preset in un file SoundFont è abbastanza 
grande. Esistono SoundFont creati per inkudere più strumenti o preset, rispettando le tabelle GS (general Standard) 
o Yamaha XG. Altri banchi invece, possono contenere un pianoforte acustico, con gli stessi campioni raccolti in più 
preset ma con parametri effetti diversi, per dare in uscita piani acustici con diversa sonorità. Di solito si tratta di 
"banchi di variazione", cioè potrebbe esserci un pianoforte acustico leggermente diverso nel banco 1 Preset 0 (1: 0) 
rispetto a 0: 0. 
 
Un Preset può avere uno o più livelli (Layer). Nel caso più semplice c'è un solo livello, che poi deve coprire l'intera 
gamma di tasti e anche l'intera gamma di velocità. I dati del suono utilizzati per un livello sono chiamati strumento. 
La struttura dello strumento di solito contiene tutte le informazioni necessarie per creare il suono. Quindi, nel caso 
più semplice, il Preset ha un solo Layer, riferito a un singolo Strumento. NOTA: gli strumenti sono raggruppati, il che 
significa che diversi preset possono condividere lo stesso strumento. Questo è conveniente ma anche rischioso. 
Quando modifichi uno strumento, assicurati di controllare cosa succede con TUTTI i preset che utilizzano questo 
strumento. 
 
Un livello può contenere parametri (solitamente chiamati "generatori") che possono alterare il suono di uno 
strumento. Quindi, sebbene due preset possano condividere un singolo strumento, potrebbero suonare in modo 
diverso a causa dei dati del livello  
 

I livelli vengono spesso utilizzati per separare gli intervalli di tonalità e velocità, ma questa non è una regola. Molti 
Preset vengono creati "artificialmente" sovrapponendo diversi suoni di strumenti uno sopra l'altro. Un altro uso molto 
comune è aggiungere l’effetto stereo al suono con i livelli. I campioni wave utilizzati in un file SoundFont sono sempre 
monofonici. Un campione di onde stereofoniche viene quindi suddiviso in due campioni di onde monofoniche 
(etichettati ad es. "Tromba (L)" e "Tromba (R)") e due strumenti possono essere creati per questi suoni di tromba. 
Negli strati, questi due strumenti (Tromba) vengono quindi inclusi uno sopra l'altro, ma spostati completamente a 
destra e a sinistra. Lo stereo artificiale può essere creato allo stesso modo avendo uno strumento in due strati 
leggermente accordato su e giù (e pan, ovviamente). 
 
Gli strumenti, ancora una volta, sono strutturati in Split. Di solito, una divisione viene utilizzata per una certa gamma 
di tonalità e / o velocità. Uno split utilizza sempre un singolo campione d'onda per il suono e dispone di generatori 
che possono alterare il suono. Gli strumenti spesso devono fare uso di diversi split e campioni per un suono 
particolare. Per uno strumento del mondo reale, la gamma di intonazione è così ampia che non può essere ricreata 
in un sintetizzatore manipolando solo un singolo campione. Quindi, molti campioni vengono registrati e assegnati a 
una nota fondamentale. Tipicamente un campione può coprire un intervallo di tonalità uguale alla nota fondamentale 
± 5 note. Anche le divisioni di velocità sono comuni. In genere viene utilizzato lo stesso campione, ma con un livello 
di attenuazione, un filtro di frequenza e un inviluppo di attenuazione diversi. 
 
Un campione può essere utilizzato dalle suddivisioni del menu e dagli strumenti. Ancora una volta, questo è 
conveniente ma potenzialmente un rischio. Se si sostituisce un campione con un altro, potrebbero verificarsi effetti 
collaterali imprevisti. 
 
Tutto sommato, è importante capire che ci sono MOLTI parametri (di solito chiamati "generatore) utilizzabili per la 
creazione di un suono “Preset”, questo può dare luogo ad elaborazioni che consumano molta CPU. 


